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OVERVIEW 
INTRODUCTION 
Thank you for your interest in reviewing Rapid SQL® XE, Embarcadero’s heterogeneous 
SQL integrated development environment. This reviewer guide will give you an 
overview of some of the key benefits developers and project managers enjoy with Rapid 
SQL XE. 

PRODUCT DESCRIPTION 
Rapid SQL XE helps developers and DBAs produce high performance SQL code faster. 
With support for all major database platforms from a single interface, teams can 
standardize on one powerful heterogeneous SQL IDE tool. A rich development 
environment simplifies SQL scripting, query building, object management, project 
management, and version control in live databases or offline source code repositories. 
Intuitive SQL editing, debugging, and optimization tools help create high performance 
SQL code. Rapid SQL XE is ToolCloud-enabled for centralized license management and 
streamlined tool delivery. 

CONTACT INFORMATION 
We’re here to support you throughout your evaluation period — and beyond. Please 
don’t hesitate to contact us at anytime at the numbers and emails below. 
 
Technical Assistance:  
Rapid SQL XE Reviewer’s Guide Hotline is dl-DGReviewer@embarcadero.com (1-Hour 
turnaround during normal business hours). 
 
AR/PR Contact: 
Jan Liband 
jan.liband@embarcadero.com  
415 834 3131 x. 213 
 
Product Manager:  
Scott Walz 
scott.walz@embarcadero.com 
502-228-1640 
 
Product Marketing Manager: 
Elias Terman 
elias.terman@embarcadero.com 
415-834-3131 x232 
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RAPID SQL XE HIGHLIGHTS 
NEW AND INTERESTING FEATURES OF RAPID SQL XE 
• ToolCloud Built-in – The ToolCloud enables companies to simplify licensing, 

reduce costs, and control access. DBA’s have on-demand access to tools, including 
the ability to move back and forth amongst multiple DBMS versions. No installations 
required. 

• Out-of-the-box heterogeneous database support – Rapid SQL XE comes 
complete with support for all major database platforms including Oracle®, 
Microsoft® SQL Server, Sybase® Adaptive Server, IBM® DB2®, InterBase/Firebird and 
MySQL®. 

• Rich SQL development IDE – ISQL window to create, save, and execute all SQL 
code with built-in explain plans and performance execution analysis, as well as SQL 
Debuggers and Profilers to ensure code quality. 

• Cross-platform code generation options – Rapid SQL XE utilities and tools help 
Developers build SQL code that is syntactically and functionally correct the first time.   

KEY BENEFITS FOR DEVELOPERS 
• Rich and consistent feature implementations across platforms make it easy to be 

productive in heterogeneous environments or unfamiliar databases. 

• A full range of built-in object management facilities make it easy to create, edit, and 
otherwise modify database objects, programmatically or manually.  

• Easy-to-use browsing, visual query building and data editing options simplify 
working with data.  

• Diagnosis and correction capabilities increase performance and up-time. 

KEY BENEFITS FOR PROJECT MANAGERS 
• Seamless, out-of-the-box integration with all major Version Control Systems (VCS). 

• Complete database project management capabilities, which allows for the reverse-
engineering of live database objects into corresponding off-line SQL source code 
files, which may be checked into and out of any of the supported VCSs.   

• Detailed HTML reports at the database object level that can be viewed immediately 
within the application or published to a defined web directory. 

  

- 3 - 
 



 

QUICK LINKS TO PRODUCT INFORMATION 
 
• Rapid SQL XE Product Page 
• Rapid SQL XE Datasheet 
 

EXPERIENCE MORE OF RAPID SQL XE 
Rapid SQL XE’s wide range of features helps satisfy most SQL development and team 
productivity requirements. 
 

SQL DEVELOPMENT ENVIRONMENT 
Rapid SQL XE offers a fully-featured SQL editor.  The ISQL editor eases and speeds up 
the process of developing working scripts. 
 

 
 
In addition to basic text-processing functionality, the SQL editor has the following 
general features: 

• Execution options – Basic script execution, step execution, rollback and 
transaction control, and a query plan facility. 

• Automatic error detection and coding assistance – Continuous syntax 
checking minimizes coding errors.  Semantic validation ensures that object name 
references are valid.  The Code Complete feature offers intelligent suggestions 
at those points in SQL statements where objects names are specified.   

Error detection and coding assistance features are available when the Indexing 
and Parsing features are enabled.  Those features are controlled using the ISQL 
tab of the Options dialog (File > Options).  The Options dialog lets you set 
preferences for most Rapid SQL XE functions. 
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• Time savers - Code templates are complete code blocks that can be easily 
added to open windows or scripts with a few keystrokes.  When you type 
CTRL+SPACE, the Code Assist menu opens, letting you select a code template 
for insertion in the editor window.  Auto Replace lets you define shortcuts 
consisting of a few characters that represent longer character strings. Instances 
of these Auto Replace expressions are automatically replaced by the 
replacement string on activation events such as typing SPACE, TAB, or RETURN. 
This feature is useful for creating shortcuts for one-line commands or SQL 
statement subsets, or even to detect and fix common typographical errors such 
as teh for the. 
 

These time-saving features are configured from the Code Workbench (Tools > 
Code Workbench).   

• Environment control features  - Let you set query options, lock session 
connections, and execute scripts against multiple datasources. 

• Results editor – Query results are displayed, spreadsheet-fashion, in a Results 
editor.  It offers a wide-ranging set of options for formatting, navigating, editing, 
and exporting result data.  

SQL PRODUCTIVITY FEATURES 
Rapid SQL offers a number of code generation and execution facilities designed to save 
time and let you perform disparate development tasks from a single environment. 

QUERY BUILDER 
The Query Builder provides a visual interface that lets you construct complete, 
advanced queries. 
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The utility lets you: 
• Specify a statement type (SELECT, INSERT, DELETE, UPDATE, CREATE VIEW) 

• Specify the tables and columns used in the query 

• Build complex clauses 

You can view the graphical structure of your query as you work, review using 
functionality such as syntax checking, as well as save and reopen queries. 
 

RAPID CODE GENERATION 
The Code Generation Facility (Tools > Code Generation Facility) can be used to 
create complete procedures, functions or packages based on views or tables. 
 

 
 
The generated DDL is displayed in a DDL Editor.   
 
Similarly, a set of Generate object actions, available against table and views, let you 
quickly generate simple procedures or individual statements based on column 
selections. 
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When working in the SQL editor, the Paste SQL Statement and Paste SQL Syntax 
options let you quickly add templates for individual statements or more complex and 
syntactically-correct code blocks to your script.   
 

 
 

SIMPLE SCRIPT AND FILE EXECUTION FROM THE RAPID SQL 
ENVIRONMENT 
Rapid SQL extends the auto-generation of SQL code by allowing you to run your scripts 
across multiple databases at the same time.  The Script Execution Facility and File 
Execution Facility are standalone utilities that establish multiple threads and database 
connections letting you simultaneously execute SQL statements or ANSI SQL files 
against multiple datasources.  
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THE SQL DEBUGGER 
The Embarcadero SQL Debugger lets you locate and fix bugs and perform general 
testing.  Depending on the DBMS platform, you can debug functions, procedures, and 
triggers.  In addition to a typical execution window, the SQL Debugger offers 
supplemental windows that let you set and watch variables, and view dependencies and 
the call stack. 
 

 
 
The following debugging/interpreted mode features are included: 

• Providing input parameter values 

• Step execution options (Step Into, Step Over, and Step Out ) complement 
standard start, stop, and restart options 

• Setting and toggling breakpoints 

REPORTING AND ANALYTICS 
Rapid SQL provides reporting and analytics in areas ranging from code performance, to 
object details, to size and space statistics. 

CODE ANALYST 
The Code Analyst (Tools > Code Analyst) allows you to capture run-time statistics on 
executable database objects, included stored procedures and functions.  Not only can 
you capture runs for single objects, but you can group more than one object. 
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When initiated (Tools > Code Analyst) a Wizard walks you through defining a session, 
selecting the objects to be executed, and providing other details. On completion, tabs 
in  resulting window provide details such as: 
 

• Total time for the run. 
 

• A breakdown of the different objects that make up the session. 
 

• Specific time measurements for individual SQL statements. 
 

OBJECT DOCUMENTATION AND REPORTING 
Rapid SQL provides rich, detailed HTML reporting for all database objects. Right-
clicking an object in the explorer and selecting Report from the context menu, lets you 
display and save a detailed HTML report on that object. 
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TEAM COLLABORATION 
Rapid SQL provides an excellent team development environment by allowing you to 
Reverse Engineer live database objects into off-line SQL source code files that can then 
be easily added to a Version Control System (VCS).   
 

 
 
Rapid SQL’s seamless VCS integration offers all version control operations, such as get, 
check-out, check-in, history and diff.   
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DATA MANAGEMENT 
Rapid SQL XE provides comprehensive facilities to help you manage the data in all of 
your databases.  A visual data editor helps you add, change, and delete data from your 
tables with all referential integrity enforced.  You can create insert statements for tables 
using current data and also extract data as XML documents for certain databases.   

VISUAL DATA EDITOR 
Rapid SQL XE’s visual data editor helps you add, change, and delete data from your 
tables with all referential integrity enforced.  When you invoke the data editor against a 
table, you are prompted to create a SELECT statement.  You choose the columns to 
include and optionally, provide a WHERE clause.  The qualified data is displayed in a 
spreadsheet-style editor. 
 

 
 
Data is edited manually, cell-by-cell.  If you are using LIVE mode, your changes are 
made every time you move off of an updated or inserted row and deleted rows are 
immediately removed from the database.  Batch mode allows you to make changes and 
then save all changes in a single operation. 

XML/DML UTILITIES 
The Create Insert Statements utility lets you generate INSERT statements 
corresponding to all the data or a subset of the data in a table.  An initial step lets you 
qualify the data by selecting columns and providing a WHERE clause.  The resulting 
statements are opened in an active ISQL editor window. 
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The Extract Data As XML feature provides a comparable function.  It lets you make 
table data available in XML format.  After qualifying records and columns, the resulting 
data is opened in an XML editor. 

JOB MANAGEMENT 
Rapid SQL XE freely integrates with the Microsoft Windows Task Scheduler, which 
allows you to schedule virtually any task to run on your own computer whenever and 
how often you’d like.  The scheduler is available while performing many Rapid SQL XE 
tasks.  
For example, a useful object management/DDL integration feature is invoked by right-
clicking a table in the Datasource Explorer and selecting Extract from the context 
menu.  When the extracted DDL for the table opens in an ISQL editor, the scheduler 
can be invoked from the toolbar. 
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The Scheduler Action dialog lets you provide a name, set notifications, and specify an 
output directory for the new job. Clicking OK opens the Windows Job Scheduler where 
you finish scheduling the task and inspect the results when it completes. 

Datasource Management 

After installing Rapid SQL XE, you must set up datasources to establish reusable 
connections to your database servers.  Rapid SQL XE stores information about the 
datasource specification in the system registry and provides a visual interface for 
maintaining it.  
 

REGISTERING AND MAINTAINING DATASOURCES 
In order to use Rapid SQL XE with the datasources on your network, you must first 
register them.  There are two primary methods of registering datasources.  Rapid SQL 
XE offers a Datasource Registration Wizard that lets you register datasources 
manually, providing credentials and connection information, yourself.  Alternatively, you 
can use the Discover Datasources feature to semi-automatically find and register all 
datasources on our network. 
 

 
 
Related options include import and export of datasource definitions and the ability to 
share datasources across Embarcadero applications.   
 

CONNECTING TO DATASOURCES 
Manually connecting to a datasource is a simple right-click operation, with an 
intermediate step that prompts for user credentials.  Alternatively, you can configure 
the datasource registration with credentials, eliminating the intermediate step in 
connecting.  Rapid SQL XE can be connected to multiple datasources simultaneously. 
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DATABASE EXPLORER 
Rapid SQL XE provides a Database Explorer that lets you navigate your datasources 
and view details on individual objects.  The explorer provides a hierarchical view, letting 
you drill down from the database level all the way to the level of individual database 
objects.   
 

 
 
From a purely visual perspective, you can color-code individual datasources according 
to customizable schemes, for example to easily discriminate among, production, 
testing, and development servers.  The explorer display can be filtered by object name 
or type, helpful for ad hoc visual searches or for sites with large numbers of 
datasources. 
 

OBJECT MANAGEMENT 
Rapid SQL XE supports all major object types on supported DBMS platforms.  For 
example, the following shows object type support for the DB2 for Linux, Unix, and 
Windows, Microsoft SQL Server, and Sybase Adaptive Server platforms. 
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WIZARDS AND EDITORS 
Wizards and Editors are available for creating and modifying most supported object 
types.   
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Rapid SQL XE object properties correspond to CREATE object_type and ALTER 
object_type clauses, options, and keywords, appropriate to the object type and DBMS 
platform.  In addition to basic properties, the wizards and editors offer object-specific 
options such as column definitions for tables, and let you work with common 
characteristics such as permissions/privileges and dependencies.  Lastly, you can 
inspect the DDL generated to create or edit an object before submitting it to the server. 
 

OBJECT ACTIONS 
Rapid SQL XE also offers a number of simple or common object type-specific actions 
that can be applied to individual objects.  
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While object action availability differs by DBMS platform, they are most commonly 
implementations of: 

• ALTER OBJECT TYPE clauses/options/keywords not typically available from 
object editors, such as REBUILD INDEX and RENAME 

• SQL commands such as TRUNCATE, REORG, and LOCK 

• System procedures and other available utilities 

Most object actions are implemented as multi-panel wizards that guide you through the 
action. 
 
 

DATABASE SECURITY 
Rapid SQL XE can help you efficiently establish and maintain database security.  
Whether you are managing an existing production database or setting up a new 
environment, you’ll find consistent support across all of the supported platforms.  

DBMS-SPECIFIC, SECURITY-RELATED DATABASE OBJECTS 
Rapid SQL XE provides support for the following security-related database objects: 
 
MySQL Oracle SQL Server Sybase 

Users Profiles 
Roles 
Users 

Logins 
Roles 
Schema 
Users 

Logins 
Users 
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Wizards and editors are available for the purpose of creating and editing these objects.  
Similarly, relevant object actions such as password changes, are available against these 
object types. 

PRIVILEGES/PERMISSIONS SUPPORT 
Rapid SQL XE lets you view, grant, and revoke permissions or privileges.  When you 
open a security-related object, such as user or role, the Permissions (or Object 
Permissions or System Permissions) tab lets you assign permissions on an object-by-
object basis. 
 

 
 

Similarly, when you open an editor on an object that requires permissions for use or 
execution, such as a table or procedure, a Permissions tab lets you assign permissions 
to individual recipients. 

 
 

SPACE MANAGEMENT 
Managing space is vital to ensuring the availability and performance of your databases. 
Rapid SQL XE incorporates many built-in space features that let you smartly manage 
and exploit all aspects of your database’s storage.  
 

BUILT-IN SPACE MANAGEMENT 

The tablespace editor for Oracle datasources provides a good example of the storage 
and space data that Rapid SQL XE makes available.  The Storage tab lets you view and 
modify tablespace extent limits 
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The Space tab displays a graphical view of the Free space and Fragmentation Index for 
the target tablespace. 
 

 
 
In addition to simple viewing of space and storage details, Rapid SQL XE lets you make 
use of automated, DBMS-specific space management features.  Object editors include 
space or storage management settings.  The Sybase Tables editor, for example, offers 
support for  max_rows_per_page and reservepagegap keywords, space-management 
properties that dictate how physical pages are filled with data. 

 
 
Support for explicit actions is also provided.  For example, you can initiate shrinking of 
Oracle rollback segments, for example. 
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Embarcadero Technologies, Inc. is the leading provider of software tools that empower 
application developers and data management professionals to design, build, and run 
applications and databases more efficiently in heterogeneous IT environments. Over 90 of the 
Fortune 100 and an active community of more than three million users worldwide rely on 
Embarcadero’s award-winning products to optimize costs, streamline compliance, and 
accelerate development and innovation. Founded in 1993, Embarcadero is headquartered in 
San Francisco with offices located around the world. Embarcadero is online at 
www.embarcadero.com. 
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